
Getting Started
with Word 2003

Whether you’ve been using Microsoft Word for years, or are new
to the program, this chapter helps you get started quickly.

Long-term users will find a number of interesting new features, while
newcomers should be able to get a feel for the program and what’s
available. This chapter provides a quick tour of the Word 2003 inter-
face and then discusses basic document creation, editing, printing,
and saving functions.

Starting Word and 
Opening Documents

You can start Microsoft Word 2003 and open documents in several
ways. Learning the different methods of launching Word increases
your flexibility with the program. For example, you can choose from 
a wide selection of predefined document templates and wizards to
simplify the creation of standard documents such as memos, letters,
faxes, newsletters, reports, and so on. You probably already know
that, in Windows, you can create a shortcut icon to quickly start
Word from your desktop. If you plan to work on the same document
for several days, you also can modify the properties of the shortcut
icon so that Word automatically starts and then loads the last docu-
ment that you worked on each time you start Windows.

Starting Word from the Programs menu
In Windows, the most common way to start Word is to use the Start
menu on the taskbar. Click the Start menu button, and then choose
Microsoft Word from the Programs or All Programs menu. When
Word starts, a “pressed” button appears in the taskbar, which indi-
cates that Word is active. If you already have created a Word docu-
ment, you also can start Word by choosing Start ➪ Documents and
then selecting a Word document from the menu that appears.

Starting Word from a shortcut
You also can access Word from the desktop or any drive or folder by
creating a shortcut, which is a link to a Windows program or device.
Shortcut files end with the extension .lnk, which stands for link. A
shortcut file icon looks similar to the program file icon, except that 
a small, curved arrow appears in the icon’s lower-left corner.
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4 Part I ✦ The Fundamentals

Here’s a quick way to place the Word program on your desktop using a shortcut:

1. Minimize all programs so that you can see the Windows desktop.

2. Click the Start button to open the Windows Start menu.

3. Click the Programs submenu, and find the Microsoft Word menu option.

4. Point at the Word option in the Programs menu.

5. Press and hold down the left mouse button as you drag the icon off the menu and over
the desktop—don’t release it yet.

6. Press the Alt key, and you’ll see a little curved-arrow icon—the shortcut icon. 

7. Release the mouse button, and a shortcut icon is placed on the desktop.

8. Release the Alt key.

You can also place this icon in the Quick Launch area of your Windows taskbar so that you
can start the program quickly by clicking the button there. (The taskbar is the bar on which
the Start menu sits.) Carry out the same dragging operation, but drop the icon onto the Quick
Launch area instead of on the desktop. Alternatively, you can drag the icon off the desktop
and drop it onto the Quick Launch area.

You can easily delete the Word shortcut by right-clicking the icon and choosing Delete.

If you upgraded from Office 2000, you may still have the Office Shortcut bar installed, which
gives you another way to start Word. If the Shortcut Bar is a feature that you like and use, you
already know about it, so we won’t waste time discussing it here. If you did a clean install of
Office 2003, you won’t see this feature.

Starting Word with Windows
If you want Word to run whenever you start Windows, add the Winword program file to the
Startup folder in the Start menu. To add Word to the Startup folder using Windows, follow
these steps:

1. Open the Windows Start menu.

2. Click the Programs submenu, and find the Word menu option.

3. Point at the menu option in the Programs menu.

4. Press and hold down the mouse button while you drag the icon off the menu and place
it over the Startup menu—don’t release it yet.

5. Press the Alt key, and you’ll see a little curved-arrow icon—the shortcut icon.

6. Release the mouse button, and a shortcut icon is placed in the Startup menu.

7. Release the Alt key.

Opening a Document from Word
After you create and save a document, the file exists on your disk. To use Word to make
changes to the file or to save a copy of it under a different name, you need to open that file.
Word provides several methods for opening files. The easiest is to click the Open button on
the Standard toolbar. Another is to choose File ➪ Open or press Ctrl+O. Both methods take
you to the Open dialog box, where you can locate the file that you want (see Figure 1-1).

Note
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5Chapter 1 ✦ Getting Started with Word 2003

Figure 1-1: The Open dialog box, showing the Details view.

With the Views button (the little icon second from the right) on the Open dialog box toolbar,
you can change the display of your files. Click the drop-down arrow on the right side of the
button and play with the various views offered:

✦ Large Icons: Displays each file as a large icon with its name underneath. Quite frankly,
this is a very inconvenient way to display files and makes it difficult to find things. We
suggest you use a different view.

✦ Small Icons: Much the same as the prior choice but with smaller icons.

✦ List: An alphabetical list of files, which is much easier to work with.

✦ Details: A list showing each file’s size and date of last modification.

✦ Properties: Select a file in this view, and a pane on the right displays the file’s 
properties.

✦ Preview: Select a file, and you can actually read the contents of the file in the right
pane.

✦ Thumbnails: Each file is displayed as a picture. This view doesn’t work with Word 
document files unless the document author specifically saved a thumbnail image (see
Chapter 7). The Thumbnail view does work with image files and Web pages, however.

If a document is selected, the Views button on the Open dialog box toolbar also displays
details of the selected document and a window that allows you to see, as well as read, the
document.

If you worked on a document recently, that document is listed at the bottom of the File menu.
In this case, you only need to click its name to open it from the File menu. The default number
of files listed is four, but Word 2003 can list as many as nine file names at the bottom of the
File menu. You can choose how many files last opened to display by first choosing Tools ➪
Options and then clicking the General tab. The Entries box across from the Recently Used File
List option displays the number of recently used file names currently displayed in the File
menu. To display the last seven files, for example, type 7 in the Entries box.

View button
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6 Part I ✦ The Fundamentals

With Word 2003, you can quickly open any Word document by double-clicking the file name
in Windows Explorer, on the desktop, or in a My Computer folder. Word is automatically
launched, and the document is opened.

Opening documents automatically with Word
By creating a new shortcut, you can open a specified document at the same time you open
Word 2003 itself: 

1. Right-click the Windows desktop and choose New ➪ Shortcut.

2. In the Create Shortcut box, click the Browse button and use the Browse for Folder dia-
log box to find the winword.exe file (probably in the C:\Program Files\Microsoft Office
2003\Office 2003\ folder).

3. Add a document path and file name—enclosed in quotation marks—after the text that
appears in the Type the Location of the Item text box in the Create Shortcut text box.

Adding a document file name after the program name in the text box causes that document to
load automatically whenever the shortcut is used. To start Word and open a document named
Letter.doc stored in a folder named Docs on the C: drive, for example, add "C:\Docs\Letter.doc"
in the Target text box.

You can also modify a shortcut to start Word and load multiple documents by separating the
path names with a space. To load two documents named Letter.doc and Resume.doc in the
Docs folder, for example, type "C:\Docs\Letter.doc" "C:\Docs\Resume.doc".

The shortcuts created during Word’s installation cannot be edited. However, after you create
a shortcut, as described in the preceding steps, you can edit it as described in the following
section. 

Controlling Word using startup switches
Using a startup switch lets you control how Word starts. A switch is a command-line parameter
that is added after the Winword program. To add a switch, follow these steps: 

1. Right-click a Word shortcut to display the pop-up menu and choose Properties. The
property sheet for the shortcut is displayed.

2. Add the switch to the end of the Target settings command line. 

For example, you can modify the command line to include the /n switch by typing
"C:\Program Files\Microsoft Office\Winword" "/n". (The /n switch instructs Word to 
start without a default document.) Typically, Word starts with a blank document named
Document1, but you can start Word without loading that default blank document. Using this
startup option displays Word faster than the startup option of loading it with a document. 

Opening the last document
You can get Word to automatically open the last document you were working on by using the
/mfile1 switch.

You might create an icon that you use only when you want to open the last file. Note also that
you can open any of the last nine files in this manner. Typing /mfile3, for example, opens the
third from the last file you worked on.

Note

Tip
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7Chapter 1 ✦ Getting Started with Word 2003

Touring the Word Environment
The Word 2003 environment includes the elements that make up your interface with it, and
Figure 1-2 labels the main components of the Word screen. The title bar at the top of the
screen displays the program name (Microsoft Word). The Document1 file name is the default
file name assigned to a new document. The Word Control menu is represented by the letter W,
located in the upper-left corner of the title bar. The Control menu provides the menu of com-
mands for manipulating the Word program window. 

A window displayed in full-screen size is called a maximized window. The three buttons in the
top-right corner of the window minimize, maximize or restore, or exit your document, respec-
tively. (The middle button is the Restore button when the window is maximized, and it is the
Maximize button when the window is not full size.) The Restore button returns the window to
the size and position it had before it was maximized.

Figure 1-2: The parts of the Word window.

Close button

Maximize/Restore button

Minimize button

Menu bar

Control menu

Document file name Insertion point

Text area
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8 Part I ✦ The Fundamentals

The text area
The text area of the window occupies the bulk of the screen; it is where you create, edit, 
format, and view your document files. The blinking vertical bar is called the insertion point. 
It indicates where text is to be entered into a document. You also use the insertion point to
specify the point from which you want to select or edit text. In a window’s text area, the
mouse pointer appears in the shape of an I-beam.

The menu bar
Directly below the title bar is the menu bar, which contains pull-down menus that organize fami-
lies of commands for working with documents. Word 2003’s menus arrange together commands
that perform similar actions. For example, the File menu contains a group of commands that
manipulate your document files. Choosing a command tells Word what to do; for example, the
File menu contains commands to open, print, and save your documents.

You can open menus by clicking them or by pressing Alt+underlined letter shown in the
menu’s name on the menu bar. Pressing Alt+A, for example, opens the Table menu. It’s impor-
tant to note that when you open a menu, it doesn’t display all the menu options, so when we
talk about menu options in this book and you can’t find them, make sure you open up the
menu completely. You can do this by clicking the little arrow buttons at the bottom of the
menu. (You can change this behavior by choosing Tools ➪ Customize, clicking the Options
tab, and selecting Always Show Full Menus.)

Toolbars
Word comes with a number of toolbars, each of which contains a series of buttons designed
to perform common related tasks. To display a list of available toolbars, choose View ➪
Toolbars; a submenu of toolbars appears. Currently displayed toolbars have a checkmark
next to them. An even quicker way to choose a toolbar is to display a pop-up toolbar menu by
clicking the right mouse button anywhere on a toolbar.

Moving your mouse pointer over a toolbar button displays the name of the button, which
often gives you a clue regarding its function. This pop-up button name is called a ScreenTip.

You can customize a toolbar by adding commands to it or by replacing the commands on the
toolbar with those of your own choosing. You can create a customized toolbar for each type
of document that you regularly produce. For example, you can create a toolbar with buttons
to access a regularly used command, such as creating a Search and Replace button to replace
the frequently used chart or columns buttons.

For more information about customizing toolbars, see Chapter 32.

Word 2003 displays the Standard and Formatting toolbars by default. With these toolbars, you
can access the most commonly used commands with the mouse instead of having to choose
commands from the menus. For example, to print a document, click the printer icon instead
of choosing the File ➪ Print command. This action immediately prints the document without
displaying the Print dialog box.

Word may display other toolbars, depending on what you are doing at the time. If, for
instance, you are working with a document that has revision marks in it (see Chapter 29),

Cross-
Reference
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9Chapter 1 ✦ Getting Started with Word 2003

Word automatically displays the Reviewing toolbar. If you are working on a picture or draw-
ing, Word may display the Picture or Drawing toolbar.

The Standard and Formatting toolbars are normally anchored just below the menu bar. When
you display other toolbars, however, they either appear stacked in the order that you display
them or float on-screen like small windows. Some, like the Drawing toolbar, anchor themselves
to the bottom of the screen (above the status line). 

To move a toolbar, simply use the drag bar to drag the toolbar to where you want it to be 
displayed. The drag bar is indicated by four little dots on the left side of the toolbar or in the
top-left corner (depending on where the toolbar happens to be). Point at this bar, press and
hold down the mouse button, and drag the bar to the position you prefer. You can place a
toolbar on any window edge—top or bottom, left or right—or let it float inside the window.
You can also change a floating toolbar to an anchored toolbar by double-clicking the drag bar.
Figure 1-3 displays several toolbars, both anchored and floating. 

Figure 1-3: Sample toolbars.

The Standard toolbar
The Standard toolbar includes both frequently and infrequently used commands for working
in Word 2003. Figure 1-4 shows the buttons on the Standard toolbar, and Table 1-1 describes
what these buttons do.

Figure 1-4: The Standard toolbar.
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10 Part I ✦ The Fundamentals

Table 1-1: The Standard Toolbar Buttons

Button Name Action

New Blank Document Opens a new document based on the current
default settings.

Open Opens an existing document or template. Word
displays the Open dialog box, where you can
locate and open the desired file.

Save Saves the active document or template under 
its current name. If you have not yet named the
document, Word displays the Save As dialog box 
so that you can do so.

Permission If you have installed the Information Rights
Management Service (see Chapter 34), you will
see this button on the toolbar. It lets you restrict
the use of the document by preventing recipients
from copying, printing, or forwarding it.

Print Prints all pages of the active document.

Print Preview Displays the layout of a document as it will appear
when printed.

Spelling and Grammar Checks the spelling and grammar of the entire
document, or if you have selected text, checks 
the spelling of that selection. Word displays the
Spelling dialog box when it does not find a word 
in the dictionary.

Research Opens the Research task pane, where you can find
synonyms, look up words in a dictionary, consult
an encyclopedia, and so on.

Cut Removes selected text and graphics from the
document, and stores them on the Clipboard.

Copy Copies selected text and graphics and stores them
on the Clipboard.

Paste Inserts the contents of the Clipboard at the
insertion point or over the selection.

Format Painter Copies character formatting to other selected text.

Undo Reverses your last action. Clicking the down arrow
attached to the Undo button lets you choose from
a list of the most recently changed operations. 

Redo Repeats the last change you made to a document.
Clicking the down arrow attached to the Redo
button lets you choose from a list of the most
recently changed operations.
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11Chapter 1 ✦ Getting Started with Word 2003

Button Name Action

Insert Hyperlink Opens a dialog box for inserting a URL in your
document. You can create a link to a file on your
own computer, the Internet, or an office-wide
network.

Tables and Borders Opens the Tables and Borders toolbar.

Insert Table Inserts a table. To select the number of rows and
columns, drag over or past the sample table that is
displayed. The sample then expands as you drag
the pointer.

Insert Microsoft Inserts a Microsoft Excel worksheet into your 
Excel Worksheet document.

Columns Formats the current section of your document with
one or more newspaper-style columns. To select
the number of columns, drag over the sample
columns that are displayed. The number of sample
columns then expands as you drag the pointer.

Drawing Displays the Drawing toolbar.

Document Map Opens a separate window to the left of your
document that shows an outline of your
document’s headings. Jump to any heading in your
document by clicking it in the Document Map. 

Show/Hide Makes normally invisible, nonprinting characters
such as tabs and paragraph marks visible for easier
editing.

Zoom Determines how large or small a document
appears. Choices include 500%, 200%, 150%,
100%, 75%, 25%, 10%, Page Width, Text Width,
Whole Page, and Two Pages. The default setting is
100%, but you can type any integer value from
10% to 500%. Note that the contents of the menu
depend on the view you have selected.

Microsoft Word Help Displays Office Assistant’s Search dialog box or the
Microsoft Word Help window.

Read Puts your document into Word 2003’s new e-book
reading mode, to make the document easier to
read. 

More Buttons The little down triangle at the end of the bar lets 
(down triangle) you quickly add or remove buttons on the toolbar

or change settings.
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12 Part I ✦ The Fundamentals

Your toolbar may have other buttons; many programs automatically add buttons to the tool-
bar. (Some programs, such as Adobe Acrobat, even create their own toolbars.) Some label
printers add an icon to the toolbar so that you can highlight text and click the button to send
the text to a label. You can reset the toolbar or add and remove buttons by clicking the trian-
gle at the right end of the toolbar and choosing Add or Remove Buttons ➪ toolbar name. A
menu opens and displays all the available buttons (click one to add or remove it), and at the
bottom is the Reset Toolbar command.

The Formatting toolbar
The Formatting toolbar displays controls that affect the appearance of characters and para-
graphs in your document. As you move the insertion point through the document text, the
Formatting toolbar reflects the formatting applied to that text. Figure 1-5 shows the buttons
on the Formatting toolbar, and Table 1-2 describes what these buttons do.

Figure 1-5: The Formatting toolbar.

Table 1-2: The Formatting Toolbar Buttons

Button Name Action

Style Determines the style to apply to selected
text. A style is a collection of character and
paragraph formatting instructions that are
commonly used together. Word 2003
includes several styles and also allows you
to create your own. The default style is
Normal.

Font Displays the Font list box for choosing
different typefaces. The default font is
Times New Roman.

Font Size Displays a Font Size (Points) list box for
controlling the size of characters. A point is
1⁄72 inch. In addition to using the drop-down
list box, you can directly enter any point
size between 1 and 1,638, including half-
point sizes such as 10.5 or 100.5. The
default size is 12 points.

B (Bold) Applies boldface to selected text. If no 
text is selected, but the insertion point is
inside a word (and the When Selecting,
Automatically Select Entire Word option has
been selected in the Edit tab of the Options
dialog box), Word applies bold to the word.

Note
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13Chapter 1 ✦ Getting Started with Word 2003

Button Name Action

I (Italics) Italicizes text.

U (Underline) Underlines words and spaces.

Align Left Aligns the current or selected paragraph
along the left indent. Align Left is the
default setting.

Center Centers the current or selected paragraph
between indents.

Align Right Aligns the current or selected paragraph
along the right indent.

Justify Distributes the current or selected
paragraph text between the left and 
right indents.

Line Spacing Adjusts the spacing between lines.

Numbering Numbers the selected paragraphs
sequentially by inserting an Arabic numeral
(1, 2, 3, and so on) in front of each, and
aligns the paragraph text 1⁄4-inch to the right
of the numbers.

Bullets Places a bullet in front of each selected
paragraph, and aligns the paragraphs 
1⁄4-inch to the right of the bullets.

Decrease Indent Moves selected paragraphs left, to the
previous default tab stop. The default
setting is 1⁄2-inch.

Increase Indent Moves selected paragraphs right, to the
next tab stop. The default setting is 1⁄2-inch.

Borders Displays the Borders toolbar, which you can
use to add borders and shading to selected
paragraphs, table cells, graphics, and
frames.

Highlight Highlights words and spaces using a color
that you specify.

Font Color Allows you to quickly change the color of
the current font.

More Buttons The little down triangle at the end of the 
(down triangle) bar lets you quickly add or remove buttons

on the toolbar or change settings.
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The Task Pane
Word provides another, special form of toolbar called a task pane. This pane is displayed
automatically under certain conditions, and a variety of commands also open it. You can
choose View ➪ Toolbars ➪ Task Pane or Tools ➪ Research to open a particular task pane 
setting.

The task pane is actually a dozen or so specialized toolbars in one. Choosing Tools ➪ Research
opens the Research task pane. But after the Research pane is open, you can choose a differ-
ent pane. Figure 1-6 shows the Home task pane. If you click the black triangle to the right of
the task pane title, a list of panes opens. Table 1-3 describes the available panes.

Figure 1-6: The task pane, with the Home pane displayed.

Home Open

CloseForward

BackDrag bar
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15Chapter 1 ✦ Getting Started with Word 2003

Table 1-3: The Task Panes

Task Pane Name Purpose

Home Provides a quick way to open existing or new documents, and links to
Microsoft’s Office Web site and online news.

Help Provides a way for you to access information about Word, both in Help
files on your computer and online.

New Document Tools for starting new documents, including the ability to find templates
on Microsoft’s Web site.

Search Results A tool for searching the Microsoft Web site for various types of
information, including Assistance, Training, Templates, Clip Art and Media,
and Office Marketplace.

Clip Art Find clip art and other media files in a variety of locations.

Research Use a thesaurus or dictionary, search an encyclopedia, carry out an
Internet search, find a stock quote, and more.

Clipboard Advanced clipboard functions let you save multiple items on the clipboard
and paste them all together or in different locations.

Shared Workspace A system that allows you to save documents centrally so that other users
can collaborate with you.

Document Updates Used in conjunction with the Shared Workspace to find updated
documents.

Document Protection Settings for protecting your document.

Styles and Formatting A tool for working with paragraph and font styles and formats.

Reveal Formatting Displays details about the formatting of the selected text.

Mail Merge A wizard used for creating mail-merge letters, e-mail messages, envelopes,
labels, and directories.

XML Structure A tool for working with XML tags within your document.

XML tags are explained in Chapter 27. For now, all you need to know is that you probably
don’t need to know anything about XML.

As Figure 1-6 illustrates, the task pane gives you several tools for moving the pane and for
navigating around inside it:

✦ Drag bar: Enables you to increase or decrease the area taken up by the task pane.

✦ Open: Opens the task pane list from which you can select another pane.

✦ X: Closes the task pane.

✦ Left arrow (Back): Displays the prior task pane.

✦ Right arrow (Forward): Displays the task pane from which you have just come after
using the left arrow.

✦ Home: Displays the Home task bar.

Cross-
Reference
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The ruler
Word 2003’s horizontal ruler shows and also adjusts the margin indent and tab settings of
paragraphs. The ruler is displayed across the top of the window to provide you with a quick
way to change paragraph indents, adjust margins, change the width of newspaper-style
columns, change the width of table columns, and set tab stops using the mouse. To display
and hide the ruler, choose the View ➪ Ruler command. The measure, which by default is in
inches, displays the available text area width, indent markers, and tab settings. The ruler also
displays applied settings as you move the insertion point through your document. The zero
point on the ruler aligns with the left boundary of the first paragraph of the selection.

With this ruler, you can adjust settings for selected paragraphs or for the paragraph that 
contains the insertion point. To change settings for one or more paragraphs using the ruler,
move the insertion point into the paragraph or select the paragraphs you want to change.
Then drag a marker on the ruler, and set tabs by clicking the ruler at various points along 
the horizontal ruler bar. Word also includes a vertical ruler, which appears only when your
document is displayed in Print Layout view or Print Preview.

The scroll bars
At the far right side of the window is the vertical scroll bar. Clicking the arrow buttons located
at the top and the bottom of the vertical scroll bar scrolls the document, one line at a time, in
the direction of the arrow. The box within the scroll bar is called a scroll box. Its position in the
scroll bar indicates the position of the insertion point relative to the size of your document as
a whole. By dragging the scroll box with the mouse, you can move up or down (forward or
backward) in your document. As you scroll through your document using the scroll box, a
box appears to the left of the scroll bar that shows you the current page number.

Three additional buttons appear at the bottom of the vertical scroll bar as well. The double-
headed arrows move you up or down in a unit defined by the middle button (the one with 
the circle on it, the Browse Object button). Clicking the Browse Object button allows you to
choose how you want to move around the document. Most of the choices affect the double-
headed arrows. For example, choose Browse by Heading and the double-headed arrows move
you from heading to heading, up or down, depending on which you click. (Two of your
choices, Go To and Find, open the appropriate dialog boxes and have no effect on the double-
headed arrows.)

Once in a while, you may find it convenient to split the window so that you can see two 
different areas of a document at one time. You can do this with the help of the split bar—the
small, unobtrusive rectangle that sits at the top of the vertical scrollbar, above the up triangle.
Click and drag it down to divide your window into two parts.

You can browse your document by moving between edits, headings, graphics, tables, fields,
endnotes, footnotes, comments, sections, and pages. This sort of movement can be a real
timesaver when you have a long document and want to review only editorial comments,
headings and footers, and so on. 

The window also has a horizontal scroll bar, allowing you to move the document right and
left. On the left side of this scroll bar you’ll find five buttons that allow you to switch quickly
between the most common document views. (Word 2003’s different document views are
explained later, in the section “Working with Document Views.”)

Note
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The status bar
At the bottom of the window is the status bar, which displays information regarding the sta-
tus of the document and the task you are currently performing. For example, when you save 
a document, the status bar displays a dotted line that reflects the amount of the file that has
been saved.

The first section of the status bar provides information about your location in the document
based on the position of the insertion point. This section shows the number of the page—this
is the number you have assigned to the page. So, for example, if this page is the first page in
section 2, and that section begins numbering with 1, this page will be page 1 (1 will appear as
the page number when you print the page), even though it may actually be the tenth page in
the document. Next, you can see the section number (sections are specially formatted parts 
of a document), followed by x/n, where x is the page’s sequence number; although when you
print this page it will show 1, this is really the tenth page in the document. n is the total num-
ber of pages in the document, so if there are 25 pages, you would, in this case, see 10/25. By
the way, you can double-click anywhere in this area to open the Go To dialog box.

The next portion of the status bar displays the precise location of the insertion point. It shows
the distance (in inches) of the insertion point from the top edge of the page, followed by the
line and column number of the insertion point’s position. A column is the character position
within the line of text; tabs and spaces are counted as characters.

The last items on the status bar indicate when certain Word features or modes are active. For
example, when you press the Insert key on your keyboard, OVR (overtype) is displayed. When
you press Insert again, the OVR indicator is dimmed. Double-clicking a mode indicator on the
status bar also turns the mode either on or off. For example, double-clicking OVR switches you
to overtype mode. In overtype mode, each character that you type replaces the character that
lies to the right of the insertion point. When OVR is dimmed, however, insert mode is active.
In insert mode, Word moves the existing text to the right to make room for the new text. You
can modify the OVR behavior by choosing Tools ➪ Options, clicking the Edit tab, and selecting
or clearing the Typing Replaces Selection check box. The following list identifies the status
bar mode indicators:

✦ REC: Records macros

✦ TRK: Tracks changes in your text

✦ EXT: Extends selections

✦ OVR: Overtypes text

Two additional status indicators also appear to the right of OVR. These include the language
being used with Word 2003 and the Spelling and Grammar Status indicator (the open book
icon). 

You can right-click on some of these mode buttons to view pop-up menus.

By default, the status bar is displayed, but you can hide it to view more of your document. 
To remove the status bar, choose Tools ➪ Options, click the View tab, and click to uncheck
the Status Bar box located in the Window section. To turn the status bar back on, choose
Tools ➪ Options again, click the View tab, and click to place a checkmark in the Status Bar box.

Note
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Office Assistant
By now, you have probably met the animated Office Assistant icon that pops up whenever
Word 2003 starts. The Word 2003 Assistant works out of the box, which means it has no win-
dow around it, so it takes up less screen real estate. Office Assistant is available to provide
help with Word 2003 using a natural language interface. You enter your queries as sentences
or questions, and the Assistant attempts to match them with the appropriate help informa-
tion. If you choose not to use the Assistant, you can still access the Word Help system using
the Microsoft Word Help window. If the Assistant is not your cup of tea for getting help, you
can shut it off completely as explained later in the section “Getting Help in Word.” Few Word
users want the assistant to stick around once they’ve learned the program!

Dialog boxes and control settings
A command in a menu or a button followed by an ellipsis (. . .) displays a dialog box after you
choose that command or button. For example, choosing Format ➪ Font. . . displays the dialog
box with control settings, as shown in Figure 1-7. Note that some controls are already set or
have text entered. These are the default settings, which you can change. Control settings vary
depending on the type of information that Word needs to activate a feature. A label identifies
each control setting. Related control settings are usually grouped together and placed inside
a box with a group label. One control setting is always active in a dialog box. You can tell
which control is active because it either has a dotted rectangle around the label or the setting
is highlighted.

Figure 1-7: The Font dialog box.

In each label, with the exception of the OK, Cancel, and Close buttons, one letter is under-
lined. You can press the underlined letter in conjunction with the Alt key to activate the con-
trol setting, regardless of which part of the dialog box is selected at that moment. 

Note
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Press the Tab key to move, in order, through the control settings and buttons—from upper
left to lower right in the dialog box. (Pressing Shift+Tab takes you through the options and
controls in the opposite direction.) You also can use the mouse to choose a control setting by
clicking the setting.

If a label for a setting, group of settings, or button is dimmed, that item is not available. When
a control setting is available, it is black. You must either click the OK button to save your set-
ting changes or click the Cancel button (or press Esc) to cancel the command before choosing
another command or typing text in a document. If you try to do something outside some dia-
log boxes, Word beeps to remind you that you first must close the dialog box. (Some boxes,
however, are designed to allow you to work in the document while the box remains available
for further use.)

Many dialog boxes use a file folder metaphor to let you choose from sets of related options.
You can organize and reference each set of options by clicking a tab. For example, note the
tab labeled Character Spacing in Figure 1-8. Clicking this tab or pressing Alt+R displays the
Font Character Spacing options, and clicking the Font tab or pressing Alt+N redisplays the
Font options.

Figure 1-8: The Font Character Spacing tab.

With dialog box control settings, you can “converse” with Word 2003 by specifying how you
want the program to affect your text. Word uses various types of controls in dialog boxes,
including tabs, option buttons, check boxes, text boxes, list boxes, and command buttons.
Figure 1-9 shows examples of two different dialog boxes. Table 1-4 describes each of the con-
trol types.
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Figure 1-9: Two dialog boxes showing the various components.

Table 1-4: Dialog Box Components

Control Setting Action

Tab Separates groups of options. Clicking the tab or pressing Alt and the
underscored character in the tab name displays the additional options.

Option button Selects a single option from multiple options in a group. Displays a dot in the
center when selected. (This is a round button, sometimes referred to as a radio
button.)

Check box Displays a check mark when the setting is selected. Check boxes often are
clustered in groups, but unlike option buttons, choosing one does not prohibit
you from choosing others.

Text box Used to enter text, such as a file name or measurement specification. When you
move the mouse pointer to a text box, the pointer changes to an I-beam, thus
indicating that you can insert text. When you select a text box, the highlighted
text is replaced with the new text that you type.

List box Displays a scrolling list of alternatives. Also includes a text box with a list of
options displayed under the text box. The drop-down list box has a down arrow
displayed to the right of the text box. When you choose the down arrow, a list
of available options appears. Word often uses drop-down list boxes to save
space in dialog boxes. If the list is longer than the list box, a scroll bar appears
at the right side of the list box. Many list boxes allow you to type your own
entry or choose an option from the list. Some list boxes, however, require you
to choose from the options in the list.

Tab

Check box

Drop-down list box

Command button

Option button
Text box

Help button
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Control Setting Action

Command button Instructs Word to perform the appropriate task or display additional information.
For example, the OK button saves your control setting changes and exits the
dialog box. If the name on the command button is followed by an ellipsis (. . .),
choosing this button either opens another dialog box related to that command
and closes the first dialog box or opens a dialog box related to that command
while leaving the first dialog box open. When the second dialog box is closed,
you may continue to select options in the first dialog box. The active command
button has a dotted rectangle around its label.

? button Opens Help information for the dialog box. 

When you perform certain options, you may find it confusing that the Cancel button changes
to a Close button. When Word 2003 completes an action that cannot be canceled, the
Cancel button changes to the Close button, which closes the dialog box without reversing
any completed changes. Clicking the Cancel button discards the options that you selected,
closes the dialog box, and returns you to your document. The keyboard equivalent to the
Cancel and Close buttons is Esc. Double-clicking the Control menu icon in the upper-left cor-
ner also closes the dialog box.

Using the Mouse and the Keyboard
You can use the mouse or the keyboard to display and choose commands from Word’s
menus. Whether you use the keyboard or the mouse, some commands require that you first
select the part of your document on which you want the command to act. These commands
appear dimmed in a menu until you make such a selection. For example, you cannot choose
Edit ➪ Cut until you select the item that you want to cut from your document.

Choosing some commands displays a bullet or checkmark next to the command name, which
indicates that command is currently in effect. If more information is needed to complete a
command, Word displays a dialog box, in which you select options to control how the com-
mand is performed. If you choose a command or feature that has not yet been installed, Word
informs you that it cannot locate the command or feature.

Using the mouse
The mouse is an indispensable tool in Word’s graphic point-and-click environment of buttons
and icons. Simply by pointing to a button or icon with the mouse pointer and then clicking 
a mouse button, you can execute a command. Mouse use has its own special lingo in the
Windows environment, and Table 1-5 lists the basic terms used throughout this book to define
such operations. Working with the mouse quickly becomes second nature. As you become
proficient with Word, you can use the mouse to integrate various keyboard shortcuts and to
perform many tasks more quickly.

When you move the mouse pointer to different parts of your screen or perform certain com-
mands, the shape of the pointer changes. The mouse pointer’s shape indicates what kind of
action is being performed. For example, the pointer is an arrow when you select commands
from a menu, an hourglass when Word is processing a command, or an I-beam when the
pointer is in a text-entry area. Additional mouse pointers can appear depending on the task
being performed.

Note
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Table 1-5: Mouse Function Terms

Term Meaning

Click Quickly press and release the left mouse button while the mouse pointer is on an
object, such as a menu command, an icon, or a button.

Right-click Quickly press and release the right mouse button while the mouse pointer is on
an object, such as a menu command, an icon, or a button.

Double-click Quickly click the left mouse button twice while the mouse pointer is on an object,
such as a menu command, an icon, or a button.

Drag Move the mouse pointer to an object, press and hold the left mouse button while
moving the mouse, and then release the button.

Point Move the mouse pointer directly to a specific location, such as a menu command,
an icon, or a button.

Using the keyboard
To choose a command from a menu using the keyboard, press the Alt key while also pressing
the underlined letter in the menu that you want to open. Then press the underlined letter in
the command that you want to execute. For example, press Alt+F and then S to execute the
File ➪ Save command. You also can use the up- and down-arrow keys to highlight a command
within an open menu, and then press Enter to execute the highlighted command. Pressing Alt
alone places you in the menu bar, in which you can then use the right or left arrow to high-
light a menu name and press Enter (or the down arrow) to open the menu. Once in a menu
you can press the left or right arrow keys to move to the previous or next menu. You also can
press Esc to exit a menu without selecting a command and return to your document.

You can choose a number of commands by pressing the shortcut keys listed on the menu to
the right of the command. With shortcut keys, you can execute a command without opening 
a menu. For example, press Ctrl+S to save a document or Ctrl+B to apply bold formatting to
selected text. Word provides many shortcut keys so that you can use the keyboard while you
work. If a keyboard shortcut is available for a command, it usually is listed to the right of that
command in the menu. Some keys also are assigned to Word commands that are not listed in
menus. For example, you can execute the File ➪ Exit command directly from the keyboard by
pressing Alt+F4.

For a list of the shortcut keys for different tasks, choose Help ➪ Microsoft Word Help (or press
F1), type shortcut keys, and press Enter.

Right-click for shortcut menus
When you point to or select certain items in Word, such as a paragraph, graphic, or table, you
can display a shortcut menu that contains commands related to that item. They appear in the
document window exactly where you are working. For example, Figure 1-10 shows the short-
cut menu for working with text in a document. To display a shortcut menu, position the inser-
tion point on the text or item with which you want to work, and then click the right mouse
button or press Shift+F10. When the shortcut menu appears, simply choose a command. To
close a shortcut menu without choosing a command, click anywhere outside the shortcut
menu or press Esc.

Tip
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Figure 1-10: The shortcut menu for working with text in a document.

Undo and Repeat
As you work, it helps to keep the Undo command in mind. The Undo command is located in
the Edit menu, and it cancels the most recent commands or actions that you’ve completed.
Clicking on the arrow to the right of the Undo button on the Standard toolbar displays a drop-
down list of the most recent actions that can be undone. Word tracks the editing and format-
ting changes that you make, so if you don’t like the results of a command or accidentally
delete some text, choose Undo. The fastest way to undo an action is to click the Undo button
on the Standard toolbar, or to press Ctrl+Z. Some actions, such as saving a document, cannot
be reversed, however. In this case, Undo changes to Can’t Undo and appears dimmed on the
menu, thus indicating this option is unavailable. You also can redo an action that you’ve
undone, using the menu option or using Ctrl+Y.

The Repeat command in the Edit menu repeats the last command or action that you’ve com-
pleted. It often is easier to choose Repeat than to choose the same command several times,
particularly when the previous command involved a complex formatting change that you
applied using the Format ➪ Font or Format ➪ Paragraph command. You can select other text
and then choose Repeat to apply the same formatting in one step. The Repeat command also
duplicates typing, so choose Repeat when you type a long paragraph and want to include the
same text elsewhere in your document. Both Ctrl+Y and the F4 key are keyboard shortcuts
for the Repeat command. 

Carefully observe to make sure that Word actually does repeat the action; in some cases you
may find that it only partially repeats.

Caution
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Working with Document Views
With Word, you can view your documents from several different perspectives. Changing views
in Word does not change the document, however. It only changes your view of that document.
Think of Word’s different views as being similar to looking at an object through a magnifying
glass. As you change the angle or the distance of the magnifying glass, the object appears to
change as well. The five main views in Word are Normal, Web Layout, Print Layout, Reading
Layout, and Outline; other views include Document Map, Full Screen, Zoom, and Print Preview.

Changing views
You manage Word’s view options from the View menu, which allows you to change to any view.
You also can use the buttons on the horizontal scroll bar to change views (see Figure 1-11).
With these buttons, you can switch between Normal, Web, Print, Reading, and Outline views.

Figure 1-11: The View buttons on the horizontal scroll bar.

To use the View menu to change views, do the following:

1. Choose View (Alt+V) to display the View drop-down menu.

2. Select the view you want to use to display your document.

Normal view
Normal (View ➪ Normal) is the default view in Word, and the benefit of working in Normal
view is speed. It is not a true WYSIWYG (“What You See Is What You Get”) view, because you
cannot see the headers and footers, footnotes, and annotations without issuing a command
from the View menu, but you can see the formatting and layout elements of the document.
This view is not appropriate when you are trying to see how the page will print, especially if
you have images in the document. In fact in some cases pictures will not even be displayed in
Normal view (pictures appear only if their wrapping styles is “inline with text”).

To speed up text entry, display graphics as placeholders. This way, you don’t have to wait for
Word to redraw the screen. To customize the Normal view to speed Word’s response time
when entering text, follow these steps:

1. Choose View ➪ Normal.

2. Choose Tools ➪ Options.

Print Layout View

Outline View

Reading Layout View

Web Layout View

Normal View
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3. Select the Draft Font and Picture Placeholders options in the View tab.

4. Click OK or press Enter.

Web Layout view
Choosing View ➪ Web Layout shows how any document would appear as a Web document.
Unlike the Web Page Preview command (on the File menu), however, this view allows you to
view how a document would appear as a Web page without starting Microsoft Internet Explorer.
You can use the Web Layout command to check out a Word document before saving it as a
Web document, thus seeing how the converted document would appear before you actually
convert it.

Print Layout view
Print Layout view is the most accurate of all views in Word (with the exception of the Print
Preview, which isn’t really intended as an editing view). It also is the slowest. Depending on
how fast your computer and graphics card work, scrolling and screen refreshing can slow
down drastically when you include graphics in a document and use Print Layout view. The
main benefit of Print Layout view is that it is a true WYSIWYG view. With it, you can see all the
elements of your document on the page, just as they would appear on a printed page (or at
least close, though for a closer-to-print-layout view Print Preview is better). It usually is most
efficient to work in the faster Normal view and then switch to Print Layout view to see how
the page would look if printed.

Print Layout view shows the vertical ruler along the left side of the document. You can
change the left and right margins in Print Layout view using the horizontal ruler, and you can
change the top and bottom margins using the vertical ruler.

You can customize Print Layout view a little. If you choose Tools ➪ Options, and then click the
View tab, you’ll find a check box labeled White Space Between Pages (Print view only). Clear
this check box to squeeze pages together in Print Layout view to save screen space. Word
removes the gray area around the pages, along with the headers and footers, and any blank
space in the margins. This check box may be disabled. If it is, close the Options dialog box,
change to Print Layout view, and return to the dialog box.

Reading Layout view
A new tool in Word 2003 is the Reading Layout view, shown in Figure 1-12, which is designed
to make the document easier to read. It does not display the document as it would look when
printed. Rather, it re-configures it into easy-to-read screen pages. You can move through a
document very quickly in this view using the arrow keys and Page Up and Page Dn keys;
these keys move you up or down one or two entire pages at a time. You can still edit in
Reading Layout view, but it’s very slow.

Tip
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Figure 1-12: The Reading Layout view.

Outline view
Outline is a specialized view that you can use to organize a document. In Outline view, you
can collapse and expand portions of the document so that you see only the headings of your
choice. You also can quickly and easily move as well as copy large portions of a document in
Outline view. The real key to using this view efficiently is to use Heading styles because Word
recognizes these styles immediately in Outline view. Figure 1-13 shows a document in
Outline view.

Document Map view
Choosing View ➪ Document Map or clicking the Document Map button on the Standard tool-
bar while in any document view displays a vertical pane along the left edge of the document
window. An outline of the document’s structure appears in this vertical pane. Figure 1-14
shows the Document Map as it appears in Normal view. Note the headings listed in the left
pane. You can use Document Map to quickly browse a long document or an online document
and to keep track of your location within it. The Document Map view works in conjunction
with Heading Styles.

Using the Document Map is a good way to get an outline view of your document even if you
haven’t used heading styles (see Chapter 25 for a discussion of Word’s Outline feature). If
you are given a document, for example, that has been badly formatted, you can use the
Document Map view in your clean-up process.

Tip
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Figure 1-13: A document in Outline view.

Figure 1-14: The Document Map view.
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Full Screen view
Wish you could hide all Word’s menus, toolbars, and rulers and have the whole screen for
writing? If so, use the Full Screen view, shown in Figure 1-15. This view simply removes all the
components around the document—the toolbars, menu bar, status bar, and, unfortunately,
even the scroll bars. 

Figure 1-15: The Full Screen view.

Begin by selecting one of the other views; then choose View ➪ Full Screen. A one-button tool-
bar appears in the lower-right area of the screen. To return to the previous view, click once
on the Close Full Screen button or press Esc.

When you are in Full Screen view, however, you can still add components back. You can
always bring the menu bar on-screen by pressing Alt or by moving your mouse pointer to 
the very top of the screen. Pressing Alt+V displays the View menu, and from there you can
choose rulers and toolbars.

Zoom
Zooming changes the magnification of the document. With the Zoom drop-down list on the
Standard toolbar, you can choose a preset percentage or enter your own percentage. Your
choices include 500%, 200%, 150%, 100%, 75%, 50%, 25%, and 10%, as well as Page Width. The
default setting is 100% percent. Choosing View ➪ Zoom displays the Zoom dialog box, which
allows you to customize your zoom settings to include Text Width, Whole Page, or Many
Pages. You can also fine-tune your zoom percentage by typing the exact percentage you want
to use. (Some options are not available in Normal view.)

03 53971X ch01.qxd  9/8/03  8:59 AM  Page 28



29Chapter 1 ✦ Getting Started with Word 2003

Print Preview
To use the Print Preview view, choose File ➪ Print Preview or click the Print Preview button
on the Standard toolbar. This view is intended for the final review before printing—to make
sure that all the pages are laid out correctly, with the correct headers and footers, paragraphs
breaking in the right places, images sitting correctly, and so on. You can work in this view, but
it’s slower than the other views and not as convenient (the toolbars have been stripped out,
for example, although you can add them back in). 

When you first enter Print Preview view, there’s no mouse-insertion I-beam. Rather, the mouse
controls the zoom. Click on the document to zoom in. If you want to edit in this view, click the
Magnifier icon in the toolbar and then click to place your insertion point appropriately in the
document.

Adding Thumbnails
Choose View ➪ Thumbnails to add a column on the left side of your window that displays
thumbnail images of each page. This is available for the Normal, Web Layout, Print Layout,
Reading Layout, and Outline views. You can use the thumbnails as a navigation tool. Just click
an image to jump to a particular page. 

You can’t change the size of the thumbnails, but you can expand the size of the pane in 
which they are displayed. Drag the border to expand the pane so that instead of a single 
column of thumbnails, you end up with two or more columns. Close the Thumbnail pane 
by double-clicking the border or by choosing View ➪ Thumbnails again. However, note that
double-clicking is only a temporary close. Next time you open the document, the thumbnails
will be back. To get rid of them for good you have to choose View ➪ Thumbnails again.

Creating a New Document
Recall that when you first open Word, a new, blank document called Document1 appears. 
To begin working, just begin typing. By default, this new document is based on the Normal
template. A template is a special file that Word uses as a basis for creating a document, and
every document created in Word is based on a template. Templates can contain text, styles,
AutoText entries, macros, customized menus, customized keystroke assignments, and cus-
tomized toolbars. So, for example, when you create a memo, instead of typing the same head-
ings and applying the same formats each time, you can just use a template that already
contains these elements.

See Chapter 14 for more information about Word’s templates and how to use them to make
document creation easier and more efficient.

Word comes with templates for many different types of documents, such as memos, reports,
and business letters. You can use these templates as they are, modify them, or even create
your own. If you do not choose any other template, Word uses the Normal template, which is
a general, all-purpose template containing only a few basic definitions, such as the font and
font size, margin settings, and line spacing.

The standard, stripped-down Normal template includes minimal formatting options. Table 1-6
lists Word’s Normal template default settings. You can choose from a list of predefined tem-
plates in addition to the default template. To create a new document with Word’s Normal 
template is easy. Just click the New Blank Document button on the Standard toolbar.

Cross-
Reference
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If you make changes to the Normal.dot template that you later regret, you can change back
to the default Normal.dot template by deleting the Normal.dot file. You can find out where
this file is located by choosing Tools ➪ Options, clicking the File Locations tab, and then look-
ing at what’s listed beside the User Templates entry. After you delete Normal.dot, Word auto-
matically creates a new Normal.dot the next time you start the program.

Table 1-6: Word’s Normal Template (Normal.dot) Default Settings

Option Default Setting

Paper size Letter (81⁄2 x11 inches)

Left and right margins 1.25 inches

Top and bottom document margins 1 inch

Line spacing Single

Justification Align left

Tabs 0.5-inch

Font Times New Roman

Point size 12 points

View Normal

Starting a new document with a template
Word includes several preconstructed templates for creating documents such as letters,
resumes, memos, and so on. To create a new document and select one of Word’s templates,
choose File ➪ New; the New Document task pane opens (see Figure 1-16). You have a variety
of options in this pane—you can select the default Blank document, a default Web document,
an XML document, and so on.

Notice the On My Computer link? Click this to open the Templates dialog box, which includes
tabs organizing the templates and wizards by document type: Legal Pleadings, Letters and
Faxes, Memos, and so on. As you click the tabs in the Templates dialog box, note the variety
of templates available in Word. You can preview a template by clicking the icon, which (in
most cases) then displays the template layout in the Preview area. 

Select a tab for the type of document you want, and then choose a template or wizard icon
from the list. Make sure the Document radio button in the lower-right corner is selected, and
click OK. Word then displays either the new document with the specified template’s layout
and formatting or the wizard’s on-screen instructions for creating the document.

Using wizards to create a document
Wizards are easy-to-use programs supplied with Word that enable you to create documents
by answering a series of questions. Icons for wizard files appear with a wand in the New dialog
box. Word provides a collection of wizards for automatically creating letters, memos, resumes,
newsletters, and other common documents. Wizards use templates and include step-by-step

Tip
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instructions to walk you through creating a document. They prompt you to fill in information,
which the wizard inserts into the document. Creating a complex document—such as an
agenda, an award, a newsletter, or a resume—from scratch could take hours, but using Word’s
wizards, these documents take only a few minutes.

Figure 1-16: The New Document task pane.

To create a letter using the Letter Wizard, follow these steps:

1. Choose File ➪ New. The New Document task pane opens.

2. Click the On My Computer link. The Templates dialog box appears.

3. Click the Letters & Faxes tab.

4. Double-click the Letter Wizard, and a small dialog box appears. 

5. Select whether you want to Send One Letter or Send Letter to a Mailing List. 
The appropriate wizard dialog box appears. Figure 1-17 shows a sample Letter 
Wizard dialog box.

6. Answer the questions in the dialog boxes, and then follow the instructions. Word then
sets up the basic formatting and layout of your document.

7. To move to the next step, click the Next button. To return to the previous step, click
the Back button.

8. To create the document and close the wizard, click Finish. Word then displays the new
document, which includes text from the wizard.
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Figure 1-17: The Letter Wizard dialog box.

Saving a Document
Until you save a document to a disk (either hard or floppy), that document exists only in your
computer’s memory. When saving a new document, you must name the file and also specify
where you want it to be saved. Word 2003 can store files using any number of formats. The
most common are the .doc and .htm formats. The .doc format is the proprietary document
format used by Word, and .htm is the universal format used for Web documents.

You can edit an existing Word file and create different versions in different formats by saving
the file in a particular format—the original file will be untouched, so you’ll end up with two
separate files. This capability enables you to exchange files with others who are using differ-
ent word processors or HTML authoring programs.

To save a document, follow these steps:

1. Click the Save button, or choose File ➪ Save (Ctrl+S). The Save As dialog box appears
(see Figure 1-18). By default, the File Name text box lists the first sentence of the docu-
ment in the text box.

2. Enter a name with as many characters as you want, within reason. The entire path-
name, including all the directories and the file name, cannot exceed 255 characters. 
For ease of use and efficiency, however, keep your file names as concise as possible.

A Word document file name can include letters, numbers, and spaces, as well as the fol-
lowing symbols: @ # $ % & ( ) [ ] _ { }. Word automatically adds the file name extension
.doc for you, so you don’t have to type it.

3. Click OK or press Enter to save your document. If you try to save a document with the
name of a previously existing file, Word displays a dialog box asking you to confirm that
you want to replace the existing document. Click No to type a different name for the
document being saved, or click Yes to replace (or overwrite) the existing document.
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Figure 1-18: The Save As dialog box.

The next time you save your document, you won’t have to type a name, of course. Pressing
Ctrl+S will quickly save the file. 

Get into the habit of pressing Ctrl+S frequently, to reduce the chance of losing work due to a
computer problem!

Word helps you to save and protect your documents in many ways. The option settings 
determine how and when you save your documents. To see what options are available,
choose Tools ➪ Options and then click the Save tab. You also can access the Save tab from
the Save As dialog box by choosing Tools ➪ General Options. This lets you change the save
settings for the current document, allowing you, for example, to define how auto-recovery
works. (You can learn more about Word’s AutoRecover feature in Chapter 7.)

You can specify any given folder to be the one in which Word saves or opens documents. By
default, Word uses the My Documents folder. To change this, choose Tools ➪ Options and
click the File Locations tab. Select Documents, and then click Modify to select a new folder.

Saving a document as a Web page
Word 2003 provides a seamless interface for creating both Word (*.doc) and Web (*.htm) doc-
uments. Because the HTML (HyperText Markup Language) format is a native file format, you
can save any .doc file as an .htm file, and vice versa. Word saves the .doc formatting as well
as the .htm formatting. This allows you to create Web documents in Word for viewing in a
Web browser. Word also reads those documents back in for editing, however. When any Word
document is saved as a Web page, almost all the document’s information, including its con-
tent, formatting, and document properties, are retained in the HTML document.

Saving a document as a Web page is easy. Choose File ➪ Save as Web Page, which displays the
Save As dialog box with the .htm file name extension already selected. You can save the docu-
ment by clicking Save. Clicking Change allows you to change the page title for the document,
which appears on the title bar of the Web browser window. You also can save a Word docu-
ment as a Web page from the Save As dialog box, just as you would any other file format—
select the format from the Save As Type drop-down menu.

Note

Caution
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Before you decide to dive right in and begin using Word to create Web pages, read Chapter 26.
The bullet list near the beginning of that chapter provides some things you might want to
consider when you’re deciding how best to create Web pages.

Getting Help in Word
Word offers several types of help, as well as different help interfaces. Here’s what you’ll find
on the Help menu:

✦ Microsoft Word Help: Opens the Help task pane, where you can type keywords to 
find information, view a table of contents, and find information on the Microsoft.com
Web site.

✦ Show/Hide the Office Assistant: Turns the Office Assistant on and off. You can click
once on the Assistant to ask a question, or right-click to view a menu from which you
can set options. The Office Assistant incorporates IntelliSense Technology to provide 
a natural language interface to the system. The Assistant also automatically provides
Help topics and tips on tasks that you perform as you work.

✦ Office on Microsoft.com: Loads the Office Web site into your Web browser. This is a
site that provides updated help information and other technical resources. You also
can download free service release updates and product enhancements, and purchase
third-party add-on tools that let you print postage, translate documents, send faxes,
and more. 

✦ Contact Us: Displays the Contact Us page on the Office Web site.

✦ WordPerfect Help: This eases the transition for users switching from WordPerfect to
Word. There is a separate Help dialog box for WordPerfect users, and you can even turn
on an option that automatically tells you how to use a Word feature when you press a
WordPerfect keystroke combination.

✦ Detect and Repair: Runs a utility that checks the Microsoft Office program files for
problems and repairs any problems it finds.

✦ Activate Product: Turns on, or registers, the program.

✦ Privacy Settings: Allows you to modify your Customer Service Improvement Program.
This is a system by which Word can transmit information, across the Internet, about
your hardware and about how you use your computer. This is anonymous information
that Microsoft is using to plan new software and determine problems with Word. It also
allows Microsoft to upload new help information to your system, and a little program
that tracks software errors. By default this system is turned on; you can turn it off if
you prefer, as many users do. How do you decide? It all depends how paranoid (or care-
ful) you want to be. Do you trust that your information will be used appropriately? If
not, turn it off.

✦ About Microsoft Word: Displays a dialog box that includes information about Word’s
version number, the product’s license, and the system information about your com-
puter and Windows settings. You will most likely need this information when you call
for technical support. If a Word feature doesn’t seem to be working, click the Disabled
Items button in this dialog box. Word sometimes disables components that are causing
problems (restarting the program may restart the functions).

In addition, you’ll find a Type a Question for Help text box on the right side of the menu bar;
type keywords in here, press Enter, and the Help task pane opens. 

Cross-
Reference
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Using the Office Assistant
By default, the Office Assistant is always on the screen. Click the icon to receive help on any
subject, and a box appears that prompts you for a search phrase. Press Enter, and the Help
task pane opens with the search results. Right-click the Office Assistant to display a pop-up
menu of Office Assistant options. Choosing Hide hides the assistant, but only during the cur-
rent session. The next time you open Word, the assistant will be back (although if you keep
hiding it, eventually it will ask if you want to hide it for good). 

If the Office Assistant is not your preferred way to get help—quite frankly, it can be very 
irritating—you can deactivate it. Right-click the icon and choose Options to display the 
Office Assistant dialog box (see Figure 1-19), which allows you to alter the situations in 
which Office Assistant offers help. Clear the Use the Office Assistant check box to permanently
hide it. (Even with the Office Assistant shut off, you can display it anytime by choosing Help ➪
Show the Office Assistant.) In the Gallery tab, you can select a different assistant. You also
can access the Gallery tab by choosing the Choose Assistant item in the pop-up menu.

Figure 1-19: The Office Assistant dialog box.

The Office Assistant really isn’t very necessary because you can reach the Help task pane any
time by pressing F1.

Using the Microsoft Word Help task pane
If you would rather use the Windows-style Help system instead of the Office Assistant, you can
turn off the Office Assistant, as previously mentioned. The Windows-style Help system uses a
Web-like interface. You can click on hyperlinks to go to related help topics. After you turn off
the Office Assistant, you can access the Microsoft Word Help task pane (see Figure 1-20) by
choosing Help ➪ Microsoft Word Help or pressing F1.

The Microsoft Word Help task pane includes three areas: 

✦ The Search area, where you type a search phrase and press Enter or click the Table of
Contents link to open, yes, the Help Table of Contents

✦ The Office on Microsoft.com area, with links to Microsoft’s Help Web site

✦ The See Also area, with a few additional links to more information
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Figure 1-20: The Microsoft Word Help task pane.

Browsing the Help Contents
The Table of Contents link displays a Table of Contents for Help topics (see Figure 1-21). The
book icons that appear in the Contents tab are referred to as chapters. Click a book to show
all the Help pages in that topic. Click an entry with a ? icon to open a Help window displaying
information about that subject.

Searching for Help
Type a search term into the Search box at the top of the task pane, and then click the green
arrow or press Enter. You’ll see the results. Click on one to open a window containing text
about that topic (see Figure 1-22). Or you can click the category below an entry to display the
Table of Contents, already open to that category, where you can browse similar subjects.

Accessing Microsoft Office Help on the Web
Word includes an option to connect automatically to an entire menu of online Help sites by
clicking Help on the menu bar and then scrolling down to Office on the Web. This way, you
have access to the entire wealth of the Internet in getting assistance with Word 2003 and with
your document itself. Click Microsoft on the Web, and select an option from the submenu.
These options connect you with a particular Internet site. You can load these sites through
any Internet browser, such as Microsoft Internet Explorer or Netscape Navigator.
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Figure 1-21: The Help Table of Contents box.

Helping WordPerfect users
Word 2003 goes out of its way to help ease your transition from WordPerfect to Word. There
is a separate Help dialog box for WordPerfect users, and you can even turn on an option that
automatically tells you how to use a Word feature when you press a WordPerfect keystroke
combination. 

Note, however, that Word is not necessarily very good at helping WordPerfect users. In fact,
Word is more useful for users of older versions of WordPerfect than new. And because turn-
ing on WordPerfect features changes the behavior of Word, it can be a source of confusion
and trouble leading to Help Desk calls.

If you are a WordPerfect user and new to both Word and Windows, choose Help ➪ WordPerfect
Help to display the Help for WordPerfect Users dialog box (see Figure 1-23). In the Command
Keys list, select a function or WordPerfect command to display to the right of the list informa-
tion about how to carry out that function in Word. If there is an ellipsis after the selected item,
double-click the item or choose Help Text to display a submenu of related items (unfortunately
there’s no way to go back without closing the dialog box and starting again!). If an arrow is next
to the item, you can click the Demo button and have Word demonstrate that feature, though
you should read the text first because it’s not always apparent what is going on. If you click
Demo when you have not selected an item with a Demo attached, the dialog box simply closes. 

Tip
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Figure 1-22: The Help task pane, along with a Help window containing explanatory text.

Figure 1-23: The Help for WordPerfect Users dialog box.

The Help Text button closes the dialog box and opens a message box carrying the help text
for the item you selected. This box stays visible while you are working in the document, so
you can follow the instructions as you work; if there’s a Demo associated with the Help item,
you’ll see a Demo button in this message box. 
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Word formatting and WordPerfect Reveal Codes
The main conceptual difference between Word and WordPerfect involves how formatting is
applied. Word is a paragraph-oriented system, and it does not use codes in the same way as
WordPerfect. If you have used HTML, you’ll understand how WordPerfect works—it tags text
to define formatting. In Word 2003, you can view the paragraph and character formatting for
specific text by pressing Shift+F1 to open the Reveal Formatting task pane. Click the text you
want to inspect to change the contents of the Reveal Formatting pane.

You also can display various nonprinting characters in your document. Click the Show/Hide
button in the Standard toolbar, or choose Tools ➪ Options and select the View tab. In the
Formatting Marks group, click the All check box to display all nonprinting characters. Or 
you can select the check boxes for the specific nonprinting characters you want to view.

Closing a Word Document
When you’ve finished working with a Word document, you have several options for closing it.
The following procedures all close a document while leaving the Word program itself running.

✦ Choose File ➪ Close.

✦ Press Ctrl+F4.

✦ Click the Close button on the right edge of the menu bar.

If you have not saved your document since the last time you made a change, Word will ask if
you want to do so. 

Exiting Word
Word creates numerous different files during the course of its operation, many of which are
stored in memory until you quit the program. Some of these files are temporary files that are
deleted when you exit Word. If you do not exit properly, however, some of these files may not
close properly, and this can result in wasted space as well as hard disk problems down the
road. Simply turning off the power switch also destroys any unsaved data. Use one of the 
following methods to exit Word correctly:

✦ Choose File ➪ Exit.

✦ Press Alt+F4.

✦ Click the Close button in the upper-right corner of the Word program title bar.

✦ Double-click the Control menu icon in the upper-left corner of the Word program 
title bar.

✦ Right-click the Microsoft Word button in the taskbar and choose Close from the pop-up
menu. (This method allows you to close Word while you are using another application.)

When you use one of these techniques to exit Word, the program tells you whether you have
unsaved data by displaying a dialog box (see Figure 1-24). This dialog box allows you to
either save your work or cancel the Exit command.
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Figure 1-24: The Word message box asks 
if you want to save your files.

Summary
This chapter has oriented you to the Word environment and shown you how to create docu-
ments quickly using the core Word tools. For example, you can now do the following:

✦ Start Word and create new documents in a variety of ways. Use File ➪ New (Ctrl+N) to
create documents using wizards and templates.

✦ Identify the essential elements of the Word 2003 environment, including document 
windows, menus, toolbars, the task pane, the ruler, scroll and status bars, and dialog
boxes. 

✦ Use the mouse and work with keyboard commands in Word.

✦ Display documents in different views using commands in the View menu.

✦ Save documents.

✦ Get help using the Office Assistant or the Microsoft Word Help window.

✦ Exit Word.

✦ ✦ ✦
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